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About this Manual

Typographical This manual distinguishes between different types of
Conventions information using the following conventions:

* Terms taken from the interface itself, such as
commands, appear in bold.

» Keys appear in small caps, for example: "Press the
SHIFT key”.

* Numbered lists mean there is a procedure to follow.

*« When the conjunction -or- appears next to a
paragraph, it means there is the choice of another
procedure for carrying out a given task.

* When a menu command contains submenus, the
menu name followed by the command to select appear
in bold. Thus, "Go to File > Open” means choose the
File menu, then choose the Open command.

This symbol highlights important information on
how a particular command or procedure works.

.

optimizing tasks, speeding up commands, and so

Following this symbol you will find hints and tips for
; on.



Administrator's Guide

About your
Product

Some of the functions described in this manual may not be
available in your product.

For the complete list of specific features available in your
software, refer to the specification sheet provided with the
product.



CHAPTER 1

Introduction

Welcome!

Congratulations! You have just acquired a complete and
secure product solution to store barcode labels, trace the
history of design modifications and print events, manage
label versions and set up approval workflows.

The ARCHIVING Server and Clients run on your company's
network in conjunction with your Label Designers, and an
optional Web module can also be used to provide limited
access to external users.

The great scalability of this product allows you to also install
all components on your PC, and work in standalone mode
like a simple desktop application.
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ARCHIVING SOFTWARE Modules

ARCHIVING
Server

ARCHIVING
Server Client

ARCHIVING
Server Web
Module

How It Works

The ARCHIVING SOFTWARE package contains several
modules: the ARCHIVING Server, the ARCHIVING Server
Client and the ARCHIVING Server Web Module.

The ARCHIVING Server is a centralized database driven
through a Windows® service. It establishes the connection
with the different data sources, and processes all client
requests: Check In, Check Out, Print History, Document
Approval, etc. The Server also uses two subsystems to
operate: UMSS (User Management System) and MSGS
(Messaging System). UMSS and MSGS respectively
perform user configuration and messaging functions.

The ARCHIVING Server Client is the add-in for the Label
Designer application. When the user invokes the
ARCHIVING Software from the Label Designer, this add-in
connects to the Server and checks user rights. If the
connection is successful then the user is allowed to perform
different document management actions such as Check In
and Check Out, and is given access to the centralized label
storage database. The actions allowed depend upon the
security settings and permissions that have been granted to
the group to which the user belongs.

The ARCHIVING Server Web Module is a Web application
accessible from any Web browser on the Internet or an
intranet. Upon successful user Web authentication, this
module establishes a connection with the ARCHIVING
Server and gives access to limited functions including
viewing documents and history records, and approving
documents before delivery in production.

The ARCHIVING Server typically runs on a server machine.
On the internal network, any client station that has a Label
Designer and the ARCHIVING Server Client add-in can
interact with the server at any time. All the ARCHIVING
Software components can also be installed on a single PC.
In that case the system works in standalone mode, like a
simple desktop application.
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Product Description

The ARCHIVING Software is designed to run on any
computer running a supported Windows® operating system.

Your product includes the following components:
+ a CD-ROM
» complete documentation
+ alicense agreement

* an activation code, which allows you to activate the
license of the ARCHIVING Server on your server
machine

If you have not purchased an activation code yet, you
can still use the ARCHIVING Software for 30 days.
During this trial period you can install as many clients
as you want, and the system will accept up to 3
simultaneous connections to the server. After the trial
period you will need to purchase an activation code. All
the work that was done during the trial period is kept in
the database, and you can continue it after activation
without any disruption.
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CHAPTER 2

ARCHIVING Server Installation

System Requirements

The basic software and hardware requirements needed to
run the Server are:

+ A PC with Windows® 2000 SP4, Windows® XP SP2,
Windows® Server 2003 SP2, Windows® 2008 or
Windows® Vista (32 or 64 bits)

+ 256 MB RAM minimum (512 MB recommended) and
1 Ghz processor for Windows® 2000 systems

* 1GB RAM minimum (2 GB recommended) and 2 or
3 Ghz processor for Windows® 2003, 2008 or Vista
systems

* A VGA monitor or better

* A hard drive with at least 500 MB of free disk space

* Microsoft® .NET Framework 2.0

» Microsoft® Data Access Components (MDAC) 2.8

» Supported database management systems (DBMS):
Microsoft® SQL Server™ family (Microsoft® SQL
Server™, Microsoft® SQL Server™ Desktop Engine

(MSDE), Microsoft® SQL Server™ Express),
Microsoft® Access, or Oracle® database



Chapter2 -6

Administrator’'s Guide

Installation

Access and SQL Server Express are not recommended
for a configuration with multiple clients.

Before running the installation program, check the
configuration of your server machine.

The ARCHIVING Server installation requires administration
rights on the server machine. Please check that all needed
permissions are granted, both at the operating system level,
and at the DBMS level, as you will be installing new
Windows services, copying program files, setting up a Web
module on Internet Information Services (1IS), and creating
new databases on your DBMS.

_ If you are installing the web module, and your plat-
! form does not yet have Microsoft ® IIS installed, it
is recommended that you install Microsoft .NET

Framework 2.0 after IS so that the ASP.NET ser-

vice registration be done automatically.

To install the ARCHIVING Server:
Step 1 > Place the CD-ROM in the appropriate drive.

The ARCHIVING Software CD window appears. Select the
ARCHIVING Server and click on Install.

If the CD-ROM does not start up automatically, go to Start
> Run, type cdsetup.exe, and click OK.

Step 2 > The Installation Wizard will appear. Click Next.

Step 3 > Read the license agreement. If you agree with the
license agreement, select “| accept the terms of the license
agreement” and click Next.
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License Agreement
Please read the following license agreement canefully,

Braton Groupe sarl License Agreement [

Braton Groupe sarl (hereafter "Braton™y ar its affiliated companies herehy
grants you a non-exclusive, nontransferable license to use this soflware and
the accomparmying dacumentation according to the fallowing terms

LICENSE GRANT - %ou may

1yinstall the sofweare an the number of computers covered by inices for this
license from Braton, which are hereby incorporated by reference;

2yuze and transmitthe softavare on 3 netwark within 5 site ifautharized by an

........ Somnn Flumdm s ol

% | accept the terms of the license agisement Frint

" | do not accept the tems of the license agreement

b

< Back Mext > | Cancel |

Figure 1 License Agreement

Step 4 > Select the setup type: Typical or Custom.

,

Welcome

Fiepair o iemowe the program.

Wwelcome to the ARCHIVING Setup Maintenance program. This program lets pou
rnadify the cunent installation. Click one of the options below.

(' Repair
ﬁ Reinztall all program features installzd by the previous setup

" Remove

@ Rermove all installed features.

et > | Cancel

Figure 2 Setup Type
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If you select Typical, the ARCHIVING Server component
and UMSS/MSGS subsystems will be installed. You will
need to select the database type before the installation can
be completed. All other settings are automatically defined
during the installation.

Selecting a Custom installation will allow you to select the
components you wish to install, and to customize their setup
on your machine. If you choose Custom, you will be guided
through the following steps:

Step 1 > Choose the Destination Location.
In this step you can choose the folder where the files will be

installed. The step is available only with the Custom
installation type.

Choose Destination Location

Select folder where zetup will install files

Setup will install ARCHIVING  Server in the following folder.

To install to this folder. click Mext. To install to a different folder, click Browse and select
another folder

Destination Folder

C:4Praagrsm Files' Brawse. ..

< Back Mext > | Cancel |

Figure 3 Choose Destination Location
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Step 2 > Select the features you wish to install.

Here you can select which components you’d like to install:
+ ARCHIVING Server
+ UMSS and MSGS

* ARCHIVING Server Web

Depending on the components you choose to install, the
following steps may differ in order.

_ The ARCHIVING Server needs UMSS/MSGS to
!i run. Therefore if you want to install only the
LABEL ARCHIVING Server, you must make sure
that UMSS/MSGS has already been installed.

Step 3 > Select the database type that you want to use.

Database Type
Select the database type that best suits pour needs.

Select the database you would like to install

" Access
¥ Sql Server
[ i

| rstallShield

< Back | Mest > I Cancel

Figure 4 Database Type



Chapter 2 - 10 Administrator’s Guide

If you select an SQL Server type DBMS, you will be asked
to enter the instance of the desired SQL Server (choose
from the drop-down menu or search for a specific location by
clicking on Browse...).

,

Databasze Server

Select database server and authentication method.

Select the databasze server ta install ta from the list below ar click Brovese to see 5 list of all
databagre servers. You can also specify the way to authenticate wour login wsing wour cument
credential: or a SOL Login [0 and Password.

Databaze Server

|lL0caI] ﬂ Browsze...

Connect using:

0 wWindows authentication
™ S0L Server authentication using the Login 1D and password below

Logiry [0 ‘

Paszword: ‘

< Back Mest = | Cancel

Figure 5 Database Server

Special installation instructions for SQL
configurations with “named instances”:

During the ARCHIVING Server installation, the
wizard may display several possible Database
Servers, for example:

1 - (Local)/DB instance name
2 -(Workstation name)/DB instance name

You must select an item that contains a workstation
name to ensure a correct connection. In our
example, you must choose item #2.

Step 4 > Select the Web site on which you want to deploy
the ARCHIVING Server Web.
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- ~

Wehb Site Settings
Specify the *Web Sile Settings
Flease select the web site an which pou want to deplop ARCHIVING Serwer Web:
Default Web Sie |
< Back Mext » Cancel

Figure 6 Web Site Settings

Step 5 > Enter the name of the Web site’s virtual directory.

w

Yirtual Duectory Sethngs
Specify the Yirtual Directary Settings

Please specify the settings far wirtusl dirsctom of the web sibe:

Nare |

Fath: |

< Back Mest > | Cancel

Figure 7 Virtual Directory Settings
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* Installing the If you are installing the ARCHIVING Server Web module
ARCHIVING Server only, you will be prompted with the ARCHIVING Server
Web module Settings window. This window allows you to select the

ARCHIVING Server address and ensure that the
ARCHIVING Software is already installed and ready to run.

ARCHI¥ING Server Settings
Specify Settings for ARCHIMING  Server

Select the addiess of ARCHIVING Server.

ARCHIVING Server l[Local Browsse

< Back | Mext > Cancel

Figure 8 ARCHIVING Server Settings

¢ Installing the If you are installing the ARCHIVING Server component

ARCHIVING Server only, you will be prompted with the UMSS and MSGS
Servers window so that you can specify the location of the
UMSS/MSGS server.
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,

UMSS and M5G5 Servers
Specify the settings for UM55 and M5GS Servers

Select the addiess for UMS5 and MSGS servers:

LIMS5: |\Dca\hast Browse
MSGES: |\Dca\hasd Erowse

< Back | Maxt » I Cancel

Figure 9 UMSS and MSGS Servers

Step 6 > Final installation step: If you are sure that the
parameters entered in the previous steps are correct, click
Install to complete the installation. If you want to review or
change any of your installation settings, click Back.
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Feady to Install the Program
The wizard iz ready to begin installation.

Click. Install to begin the installation.

[F you want ko review or change any of vour installation settings. click Back. Click Cancel to exit
the wizard.

< Back Irstall | Cancal

Software License
Activation

Figure 10 Ready to Install the Program

You can use the ARCHIVING Software in trial mode for 30
days. After that period the server is blocked. Any connection
attempt results in an error message “Maximum number of
connections reached,” and if you stop the ARCHIVING
Software Windows service, you will not be able to restart it
again. To continue to use the software you must activate the
license.

To activate the software license:

Step 1 > Launch the License Manager from the Windows
Start menu. A wizard is displayed.

Step 2 > Choose Activate and follow the wizard screens.
You will need to enter the activation code that was provided
to you when you purchased the software.

If you activate the license once the trial period is
expired, you will need to reboot the ARCHIVING Server
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ARCHIVING Server
Web Module
Configuration

computer.

After installing the ARCHIVING Server Web Module, you
should verify the Web site settings:

Step 1 > Go to Control Panel > Administrative Tools >
Internet Information Services.

Step 2 > In the navigation frame on the left, navigate to the
Web virtual directory folder (i.e., (local computer) \ Web
Sites\ Default Web Site \ LAS).

Step 3 > Right-click on the Web virtual directory folder (i.e.,
the LAS folder) and select Properties.

Step 4 > Click on the ASP.NET tab.

Step 5 > Verify that the ASP.NET version is set to
2.0.50727.

e =10l =l
Fia  Acton  View Help
- OEXERE(@ (2] =
[R trtermet Information Servees ™ [Pun e
= JB PR (ocal computer) [E3 400 dea
=) (] Web Skes %
= il Defsult web Ske 2=
% B wsHelp Vistusl Divachory | Doscurerds | Desctony Sacurity
mrcm HITF Headets | Cusstorm Emots ASPNET
ﬁnors-
Riepaats
ReportSare
FeportSarses|
Foperts]
Crvrreslnkernal
CrmmFukbc
A
&2 aop_data AGPMET wasnr 2050727 =]
= (2 bn TOANG
=) g Wirtual path 1.1 8332
-0 Took :
31 ] aipret_cherd Fie kacaian 2
5] i Dipllndk SMTP Vietual Ser
File camatuon diae: 120406 1E5252
Fibe Lot mcedifinck | BT
Ok | Conced | ook | H |

Figure 11 Web Site Properties
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Install Oracle database

Prerequisite
It is indispensable to have installed Oracle Client on

Archiving Server software before installing Oracle database.

Databaze Type
Select the databaze tppe that best suits your needs.

Select the databaze you would like ko install

 Aecess
& Sgl Server

IrstallShield

< Back I Hest » I Cancel

Figure 12 Database type

Step 1 > Select Oracle.
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LABEL ARCHI¥E Server 02.04.00.00 E

Database Type
Select the databaze tppe that best suits your needs.

Pleaze select preferable Oracle installation mode

& {Fun database sonpt adtomaticalls

" Run databaze script manually

IrstallShield

< Back I Hest » I Cancel

Figure 13 Oracle installation mode

The installation process of Archiving Server should
propose two options regarding database creation on Oracle.

« create it automatically,

* let user runs an sql script to create manually after the
install.

Automatic Automatic mode creates and/or updates tables uzed by
installation mode Archiving Server and UMSS/MSGS on Oracle database
thanks to the SQL scripts.
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Database Oracle Script

Pleaze uze the following =gl script to create Oracle database

[CREATE TABLE "TELACTIONS" ﬂ
ACTIONID INTEGER MNOT MULL,
ACTIONTYPE INTEGER,
TARGET INTEGER,
TARGETMAME MYARCHAR 2(200),
DOME SMALLINT

DESCRIPTION MWWARCHAR 2[255],

SOURCETYPE INTEGER.

SOURCE INTEGER,

COMSTRAINT “PE_TBLACTIONS" PRIMARY KEY [ACTIONID)
I:

. | o

IristallShield

< Back | Mext » I Cancel |

Figure 14 Database Oracle script.

Click Next to continue the installation.

Oracle Datab C tion Properti
Enter properties, which will be used to connect ta the Oracle
database

Datasource: IDHATEST

Uzer 10 Isystem
Password: I [T
IstallShigld

< Back | Mest » I Cancel

Figure 15 Oracle Database Connection Properties.
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Datasource: allows to give a name to the Oracle Database.

User ID: allows to define the identy or the user name which
will be used to connect to the Oracle Database.

_ During installation, the user defines a system
' operator in order to have the necessary rights to
- the creation of tables in the Oracle Database.

Password: allows to define a password.

Click Next to install the Oracle Database and to connect to
it.

Manual installation The installation displays the script of tables creation in

mode Oracle Database that are necessary for the proper
functioning of the application. Script can be use manually to
create tables.
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Uninstallation

To remove the different server components from your
computer:
Step 1> Go to Control Panel > Add or Remove Programs.
Step 2 > Select the ARCHIVING Server and click on
Change/Remove.
Step 3 > In the next window, select the Remove option and
click on Next.

- _

walcome

Modity, repair. or remove the progranm.

whelcome to the ARCHIVING Server Setup Maintenance progiam. This program lets you
modify the cunent installation. Click one of the options below.

" Modify
Select new program features to add or select currently installzd features to
Temove
" Hepai
ﬁ Heinztall all programm features installed by the previous setup.

v Femove

@ Remove all instaled features.

Next > I Cancel

Figure 16 Modify, Repair, or Remove the Program

The uninstallation program asks you:
+ Do you want to delete Databases: ARCHIVING
Server, UMSS, MSGS? (if you used SQL Data-
bases)?

_Or_
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» Do you want to backup Databases: ARCHIVING
Software, UMSS, MSGS? (if you used Access Data-
bases)?

The uninstallation program will delete the installed
components from your computer and optionally the
databases if specified.

ARCHIVING Software Repair

If the installed ARCHIVING Server components proved to
be corrupted, you can fix them by using the Repair mode
(see Figure 12).

In this mode the setup will reprocess the installation of the
different components. The installation settings that you
entered during the last installation will be reused.

SQL Database: In this mode the structure of SQL Database
will be repaired (for example, if your SQL database structure
was corrupted).

Access Database: In this mode the Access Database will
be overwritten, but before starting the repair process, the
setup will propose to “Create backup-files for your
Databases,” and after the repair you will be able to replace
the database.

ARCHIVING Modification (Add/Remove Features)

If you want to add components which were not previously
installed, you can use the Modify mode (see Figure 12). In
this mode the setup will propose to select the components
to be installed.
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Select Features

Select the features setup will install.

Select the features pou want to install, and deselect the features pou do not want ko install

CJARCHIVING Server Description
[JUMSS and MSGS Provides external access to
ARCHIVING Server ‘Wweb ARCHIVING Server

B.17 tME of space required on the C drive
2998 96 MB of space available on the C drive

< Back Next » | Cancel

Figure 17 Modify Features

Configuring E-mail Sending

In order for the ARCHIVING Software to send e-mail
notifications, an e-mail sending action must be created in
the MSGS subsystem. For more details about how to use
MSGS, please refer to your MSGS guide.

To configure e-mail sending:

Step 1 > Connect to the MSGS subsystem (accessible
from the UMSS-MSGS Servers Administration shortcut).

Step 2 > Create a standard filter for the LAS application
with the following property:
MSGCODE = MSG_SENDMAIL.

Step 3 > Create an SMTP action handler, and indicate the
parameters that your company uses for sending e-mails
through SMTP protocol (Configuration button).
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)\% Action Handler Properties - mysmtphandler

Action Handler |

Description

Imyamtphﬁmdler

=1o] x|

i~ Runtime hancller
Azsambly

Type

|Tkx ThkxSwr.Msgs.StdActions SendiMail SratpRt.dll

ITkkaxSvr Mgz Stdéctions. SendMailSmtpPt TkxSvrsgsActionSendhail SmitpRit

dl

Setup handler

" Implemented in the Runtime assembly

Assembly ITkx ThxSwr Msgs StdActions SendiailSmipUi dll
Type ITkx.TkavrMsgs StlActions. Sendbail Smtp UL TkeSvibsgsActionSendiail Srmtp Ui LI
i Information
Configuration... |
Description |myamtphandler
“ersion  |2.00 Default parameters |

oK I Cancel |

Help |

Figure 18 SMTP Action Handler Properties

Step 4 > Create an action that uses your filter and your
action handler. In the parameters zone, indicate the
following four variables:% TONAME%,%TOADDRESS%,

%SUBJECT%,%MSGTEXT%.
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E=l send mail SMTP action =10l x]

Recipients

Mame I Address I
2 TOMNAMES: “TOADDRESS 2

MNew Edit, Belete

Subject [%SUBJECT%

Message text [ pSGTENT

[ On success
™ Send message tessage setup |
O failure
’7|_ Send message lMessage setup |
(8].4 | Cancel | Help |

Figure 19 E-mail Configuration

Your e-mail sending mechanism is ready for use.

Later on, when the ARCHIVING Software will need to send
e-mail notifications, it will automatically create internal
MSGS messages. These MSGS messages will be instantly
captured by the MSGS action that you just created and
which is permanently waiting in background. The action will
populate the different variables and send e-mails via the
SMTP server.

When declaring the SMTP server, make sure that the
SMTP provider allows sending e-mails from the network
where the ARCHIVING Server is installed.
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Managing Users and Permissions

Predefined User
Profiles

* ADMINISTRATORS

* MANAGERS

The ARCHIVING Software uses the UMSS subsystem to
manage all users and permissions. At any time the
administrator can create, modify, or delete users,
passwords, and user groups. For more details about
permissions management, please refer to your UMSS
administrator’s guide.

_ In UMSS, when you create a new user for the
‘ ARCHIVING Software, you must not choose

- authentication “Windows” in the parameters of that
user. Please choose “UMSS” authentication
only.

At install time, the system creates predefined User Groups.
These groups correspond to typical profiles that a company
may need to use to manage the different user permissions
for all the ARCHIVING Software business processes.

Five different user groups are available:

Administrators have all rights on the ARCHIVING
Software, and also on UMSS and MSGS subsystems. Their
typical role is to be in charge of the IT responsibility of the
entire system.

A default Administrator user is provided. Its initial
password is “admin”.

Additional users can be created and assigned to the
Administrators group.

Managers’ typical role is to be in charge of the business data
and processes of the ARCHIVING Software. Managers
can define system settings, create approval workflows, or be
required to approve documents before delivery in
production.

Compared to Administrators, Managers do not have
permission to administrate the database or define
workstation settings. They cannot perform operations like
import DB, export DB, force undo check-out, DB archive, or
manage workstations.
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* DESIGNERS

* PRINTUSERS

* CUSTOMERS

A default Manager user is provided. Its initial password is
empty.

Additional users can be created and assigned to the
Managers group.

Designers’ typical role is to be in charge of the creation and
management of a document or a set of documents.
Designers can create documents, modify documents,
check-in new versions, submit documents for approval, and
participate in approval processes.

Compared to Managers, Designers do not have permission
to modify system settings, create or modify approval
schemes, or modify categories.

A default Designer user is provided. Its initial password is
empty.

Additional users can be created and assigned to the
Designers group.

Print Users’ typical role is to open documents and print them
in production.

Different from Designers, Print Users do not have
permission to modify documents, and they can only access
documents that are in Final state.

Print Users can use the Run-Time version of the Label
Designer to carry on their activities.

A default PrintUser user is provided. Its initial password is
empty.

Additional users can be created and assigned to the
PrintUsers group.

In some cases, documents may need to be approved by
Customers before delivery in production.

Customers, therefore, are given minimum access to the
system, including browsing their documents and all related
details, and taking part in an approval workflow.
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Customers can use the the ARCHIVING Server Web
Module, through an Internet browser, and receive
notifications by e-mail.

A default Customer user is provided. Its initial password is
empty.

Additional users can be created and assigned to the
Customers group.

predefined groups, users and permissions, except

You can freely modify, customize or delete the
; for the Administrator.

To view all permissions that are granted to a given User,
select the related Group from the “User Groups” node
in UMSS, and click on the Permission tab.

Changing the “Administrator” Password

How to Update
the Config File

The predefined Administrator user is also used by the
ARCHIVING Software system itself.

Its initial password is admin. If you change this password,
you will also need to manually change the configuration file
of the ARCHIVING Server.

_ After such an operation, if you do not update the
' ARCHIVING Server configuration file accordingly,
- the system will not work properly.

The configuration file to be wupdated is called
“TkxArv.server.config”. It is located in the installation
directory.

Once you have opened “TkxArv.server.config”, go to the
following xml section: <configuration>, then <tkxsvr>,
<umss>, <client>.
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Special Notes

You will find the <logonconfig> tag, which has the following
elements: defaultusername (Administrator), and
defaultpasswordhash, (hash for 'admin' password).

Replace the old password hash value with the new
password hash value.

The password hash value is stored in the UMSS ‘USERS’
table, within the ‘PASSWORDHASH ' field.

Once the replacement is done (using copy/paste), you must
restart the the ARCHIVING Server Windows service.

Through proper management of security and access
rights on the databases and the server system, you can
ensure that only authorized users can perform such
operations.

You can also create additional users and give them
administrator rights, by assigning them to the
Administrators group.

» The user interfaces to administrate the ARCHIVING
Server and Client are made using the MMC
(Microsoft Management Console) snap-in, so they
can be manipulated like any standard MMC compo-
nent in Windows.

« If you want to install the database on a computer that
is different from the one that hosts the ARCHIVING
Server processes and services, then full SQL Server
is required.

* Remote SQL Server running on Windows 2000
should have Service Pack 4 installed.

« If you install the ARCHIVING Software with the
Access database, the database is protected by a
password, initially set to tkllas. To replace it with a
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new password, edit “TkxArv.server.config”. This file
is located in the installation directory. Once the file is
opened, type the new password in the following xml
section:

<configuration>, then <TkxArv.DataAdapters>,
<DataAdapter name="oledb"....Password=
newpassword>. Then stop/start the “Archiving
Server” Windows service.

* For SQL Server 2005, make sure that remote con-
nections are allowed (disallowed by default).

« If you have a firewall, you must unblock ports 8088
and 8989.

* “The ARCHIVING Server” Windows service: The
Server program is run through a Windows service
named “Archiving Server,” which is configured by
default to start automatically. The service has a
dependency link with the UMSS/MSGS Windows
service, named “TkxSvr Servers service.” You can
start and stop Windows services manually by using
the standard Windows administration tool.

Before doing administration work on the

ARCHIVING Server (i.e., changing parameters
and options, importing/exporting data, etc.), it is
highly recommended to first ensure that all clients
are disconnected. If you change some settings,
you may then want to stop and restart the
“Archiving Server” Windows service for all
changes to be effective.
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CHAPTER 3

ARCHIVING Server Client
Installation

System Requirements

The basic software and hardware requirements needed to
run the Client are:

* A PC with Windows® 2000 SP4, Windows® XP SP2,
Windows® Server 2003 SP2, Windows® 2008 or
Windows® Vista (32 or 64 bits)

+ 256 MB RAM minimum (512 MB recommended) and
1 Ghz processor for Windows® 2000 systems

* 1GB RAM minimum (2 GB recommended) and 2 or
3 Ghz processor for Windows® 2003, 2008 or Vista
systems

* A VGA monitor or better

* A hard drive with at least 500 MB of free disk space

* Microsoft .NET Framework 2.0

» A Label Designer product and version that is com-

patible with this version of the ARCHIVING Soft-
ware.
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Installation

Before running the installation program, check the
configuration of your PC.

To install the ARCHIVING Server Client:
Step 1 > Place the CD-ROM in the appropriate drive.

The ARCHIVING Software CD window appears. Select the
ARCHIVING Server Client and click on Install.

If the CD-ROM does not start up automatically, go to Start
> Run, type cdsetup.exe, and click OK.

Step 2 > The Installation Wizard will appear. Click Next.

Step 3 > Read the license agreement. If you agree with the
license agreement, select “| accept the terms of the license
agreement” and click Next.

License Agreement
Please read the following license agreement carefullp,

Braton Groupe sarl License Agreement o

Braton Groupe sarl (hereafter "Braton™y ar its affiliated companies herekby
grants you a non-exclusive, nontransferable license to use this software and
the accompanying documentation according 1o the following terms

LICENSE GRANT - You may

1y install the software on the number of computers cavered by immices forthis
license from Braton, which are hereby incorporaied by reference,

T use and transmmit the software on a network within a site if authorized by an -

e im i Femane Plandme: man el

v | accept the betnnz of the license agresment Print

" | do not accept the terms of the license agieement

< Back Next > | Cancel |

Figure 1 License Agreement

Step 4 > Enter the required customer information.
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Please indicate:
* User Name
» Company Name

* Who will be able to use this application: only you or
anyone who uses the computer

Customer Information

Please enter your information,

User Name:
|

Cornpany Mane:

Irztall thiz application for:

+ Anpone who uses this computer [all users)

" Onlp for me

< Back I Cancel

Figure 2 Customer Information
Step 5 > Choose the Destination Location.

At this stage you can choose the folder where the files will
be installed.
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Choose Destination Location

Select folder where setup will install files.
Setup will install ARCHIVING Server Client in the following falder,

To install tor this folder, click Next. Toinstall to & different folder, click Browse and select
another folder

Destination Folder

C:4Pragram Files Browse. ..

< Back Mext > | Cancel |

Figure 3 Choose Destination Location
Step 6 > Select the ARCHIVING Server name.

Select the name of the ARCHIVING Server machine
to_which the Client will connect.

E

ARCHIVING Server Settings
Specify ARCHIVING Server Settings

Select the: address of ARCHIVING Server

LAas: ILocal Brawse

< Back | Mext » | Cancel

Figure 4 ARCHIVING Server Settings
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If you are sure that the parameters entered in the previous
steps are correct, click on Install to continue the installation.

If you want to review or change any of your installation
settings, click on Back.

- -

Ready to Install the Program

The wizard iz ready to begin inglallation.

Click. Install to begin the installation.

If pow want bo review of change any of your installation settings, click Back. Click Cancel to exit
the wizard.

< Back Install | Cancel

Figure 5 Ready to Install the Program
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Uninstallation

To remove the ARCHIVING Server Client from your
computer:

Step 1 > Go to Control Panel > Add or Remove Programs.

Step 2 > Select the ARCHIVING Server Client and click
on Change/Remove.

Step 3 > In the next window, select the Remove option and
click Next.

Welcome

Muodify. repair. or remowe the progiam.

‘wielcome to the ARCHIVING Server Setup Maintenance program. This program lets pou
modify the curent imstallation. Click ane of the options el

 Modify

Selact new program features to add or select cumently installzd features ta
remove

@ HAeinstall all program features installed by the previous setup

v Remove

Remove all installed features.

Mest > I Cancel

Figure 6 Repair or Remove the Program

The uninstallation program will delete the installed
components of the ARCHIVING Server Client from your
computer.
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ARCHIVING Server Client Repair

If the installed ARCHIVING Server Client proved to be
corrupted, you can fix it using the Repair mode.

In this mode the system will redo the installation of the
ARCHIVING Server Client. The installation settings that
you entered during the last installation will be reused.
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CHAPTER 4

ARCHIVING Server Administration

Logging In

[ x|

[ser |

I
Fassward I ™ Change

0k, Cancel |

Figure 1 ARCHIVING Server Administration Login

To launch the ARCHIVING Server Administration:

Step 1 > Launch the ARCHIVING Server Administration
from the Windows Start menu.

Step 2 > Type a valid user name and password (i.e.,
defined in UMSS and having appropriate permissions).

The Change check box allows changing the password at
any time.
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General Layout

n& Fichier ~ Action  Affichage Favoris  Fenétre 7
€0 BOE R THS

IFE ARCHIVING SERVER administration Connection
EE.“RCI'H\I'ING SERVER settings Tl
-4 Settings
P Functions * Intemal client
g? Histary settings
Wakermark, 5 ]— B
- @ (re i EIYEl name lozalhost I
i) Tasks Port anaa
+ Dacuments
" Eutemal client
Server name
Part
7
Uzer name
Paszword
[
Server name Q
Part
o
User name
Pazsword
-
< | &

Figure 2 ARCHIVING Server Administration

Upon successful login, the Administration window will
appear.

This window allows changing different settings for the
ARCHIVING Server module.
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General Layout

Navigation Tree

Work Pane

Navigation

Archiving Server
Settings node

The settings for the client are accessible from the
ARCHIVING Client Administration.

The layout of the Administration window of the ARCHIVING
Server follows the Microsoft Management Console
(MMC) standard.

Three buttons are added to the default set of MMC:
I Save: Saves all changes made in the current window.

= Refresh: Cancels all changes made in the current
window and refreshes its state.

s Add: Context-dependent button to create additional
items.

In this tree control the user can select all functions available
in the Administration program.

Depending on the selected node in the navigation tree, the
right-side work panes are updated.

Depending on the selected node in the navigation tree, the
work pane displays the associated settings.

Single functions are chosen by selecting a node in the
navigation tree. When there is no functionality for a parent
node, a page is shown to indicate that you must select a
subnode.

To access the Server Settings node:

Step 1 > Launch the ARCHIVING Server Administration
from the Windows Start menu.

Step 2 > Select the Archiving Server Settings node in the
navigation tree.

This node allows to set up the connection to the
ARCHIVING Server. The user must select an Internal
client or an External client connection.
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¢ Internal Client

¢ External Client

* Proxy

Specifies the settings for the internal client (this is a client
that is located on the same network domain as the
ARCHIVING Server). In this case, the TCP protocol is used.

+ Server name — specifies the name of the
ARCHIVING Server.

* Browse button — allows the user to search for the
ARCHIVING Server in the internal network.

» Port — specifies the port of the ARCHIVING Server
(8088 by default).

Specifies the settings for the external client (this is a client
that connects to the ARCHIVING Server via the Internet). In
this case, the HTTP protocol is used and all content, which
is transmitted between client and server, gets encrypted.

« Server name - specifies the name of the
ARCHIVING Server.

* Port — specifies the port of the ARCHIVING Server
(8080 by default).

* Domain authentication — If the ARCHIVING Server
is installed on a network domain that requires
authentication, authentication settings must be spec-
ified.

+ User Name — specifies the user name to use for log-
ging in to the network domain.

» Password - specifies the password.
The ARCHIVING Server may be installed on a PC, which is
placed behind a proxy. In this case, the proxy settings
should be set.

« Server Name — specifies the name of the proxy;

* Browse button - allows the user to search for a
proxy on the internal network

* Port — specifies the proxy port;
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Settings Node

Functions
Subnode

* Archiving

* Proxy authentication — the proxy may require
authentication. In this case, user credentials should
be set:

» User Name — specifies the user name.

« Password — specifies the password.

To access the Settings node:

Step 1 > Launch the ARCHIVING Server
Administration from the Windows Start menu.

Step 2 > Select the Settings node in the navigation tree.

This node allows changing functional, history and
watermark settings for the ARCHIVING Server.

When you select the Settings node, the Functions,
History and Watermark subnodes become available.

To access the Functions subnode:

Step 1 > Launch the ARCHIVING Server
Administration from the Windows Start menu.

Step 2 > Select the Settings node in the navigation tree.

Step 3 > Select the Functions subnode in the Settings
node.

This subnode allows changing functional settings for the
ARCHIVING Server.

The following settings are available in this subnode:

When the archiving is switched On, the versioning is active
for all documents. At check-in a document can no longer be
overwritten and a new version needs to be created. When
the archiving is switched Off, the document version number
is not increased at check-in. New documents overwrite
previous ones.
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* Approval

* 3-state Approval

¢ Allow Check-in

* Only work with the
ARCHIVING Software

* Password required
in approval

If approval is Off, then only the Final state can be assigned
to documents. If approval is On, then at least two document
states can be assigned: Draft and Final.

3-state Approval can only be activated if Approval is
enabled. When it is On, the In Approval state can be
chosen for documents.

The following settings: Archiving, Approval, and 3-
State Approval are defined both at category level in the
ARCHIVING Client Administration, and at global level in
the ARCHIVING Server. To be activated for a given
document, they need to be switched ON both at
category level and at global level.

When On, the ARCHIVING Server allows read/write
access to documents. When switched Off, the documents
can only be read. This setting is a global setting for all
documents in the ARCHIVING Software. It overrides the
individual user permissions (set in UMSS).

This setting affects the Label Designer application. When
switched On, the Label Designer will not allow working with
documents that are stored in the Windows file system.

Defines whether user password confirmation is required to
complete the approval process.

The Languages options allow you to specify the desired
language for the user interface.

For a language change to be fully effective you need to
close and re-open the application.

Web site settings allows you to set the URL of the
ARCHIVING Server Web Module and browse to it using
Open.
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History Settings
Subnode

) Ele Action ‘Wiew Favortes Window Help

&= | AR 2 %W

:‘1 ARCHIVING SERVER administration r Diocument Iiday “itn;
SIARCHIVING SERVER settings || : +
4 4 Sattings | ¥ Use histoay wiiting
TP Functions | [ Print
‘,‘? History setlings [ Modfication
[T Watermark [y Eror
#)-2 Managsment v " amning
=i Tasks [ Infarmation
# ] Documents |
. Max. histony sizec 20000 Records

Figure 3 History Settings Subnode in Settings
To access the History Settings subnode:

Step 1 > Launch the ARCHIVING Server
Administration from the Windows Start menu.

Step 2 > Select the Settings node in the navigation tree.

Step 3 > Select the History Settings subnode in the
Settings node.

This subnode allows changing the history trace settings of
the ARCHIVING Software.

The following settings are available in this subnode:

Use History writing: This is a global setting that determines
whether the client application can write history entries into
the database or not. When switched On, the history writing
options are enabled, allowing you to define which history
entries will be stored. When switched Off (or when no
history writing options are selected), future client history
events will not be stored in the database.

Print: When switched On, the PRINT HISTORY entry will
be written to the database after each print job.



Chapter 4 - 46 Administrator's Guide

Modifications: When switched On, the MODIFICATION
HISTORY entry will be written to the database after each
change saved to any document.

Errors: When switched On, the ERROR HISTORY entry
will be written to the database after error events.

Warnings: When switched On, the WARNING HISTORY
entry will be written to the database after warning events.

Information: When switched On, the INFO HISTORY entry
will be written to the database after information events.

Watermark
Subnode

f Eile  Action  Wiew Favorites  Window  Help
= OB 2 SKH

fm ARCHIVING SERVER administration

S ARCHIVING SERVER Sethings "Wiatermark for
[=l-42 Settings TestFrint [TEST PRINT
?F Funchions :
& History settings Repint  [COPY
(B Y abermark:

[#-d5p] Management

L Teelem

Figure 4 Watermark Subnode in Settings
To access the Watermark subnode:

Step 1 > Launch the ARCHIVING Server
Administration from the Windows Start menu.

Step 2 > Select the Settings node in the navigation tree.

Step 3 > Select the Watermark subnode in the Settings
node.

This subnode allows changing watermark printing settings
for the ARCHIVING Server.

The following settings are available in this subnode:

TestPrint: Specifies the text which will be printed over the
document when a user performs a test print (printing a
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preview) of the ARCHIVING Software document. When it is
left empty, no watermark is printed.

Re-print: Specifies the text which will be printed over the
document when a user performs a reprint of the
ARCHIVING Software document. When it is left empty, no
watermark is printed.

Management Node

"I TktAry Server MME E _|o| x|

B Fle Action View

To access the Management node:

Step 1 > Launch the ARCHIVING Server
Administration from the Windows Start menu.

Step 2 > Select the Management node in the navigation
tree.

This node allows reviewing the ARCHIVING Software
database statistics, connection and workstation information.

Favorites  Window  Help |_ Ei‘

w = | E[m| B

2

-9 Settings
=5

- Connections
.7 Tasks
-] Documents

r% ArchivingServer administratiol | Nem
;.EfliRCHMNG SERVER settings

il Database information
-5 Workstation settings

(Database information
Owworkstation setings
[Aconnections

Figure 5 Management node

When you select the Management node, the Database
Information, Workstation Settings, and Connections
subnodes become available.
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Database
Information
Subnode
By Eile  Action Wiew Favortes ‘Window Help
> BER(SH
T ARCHIVING SERVER administration Table T
 EpRCHIVING SERVER settings
-3 Settings thiSysLogon 0
% Functions
¥ History settings thldpprovalProce.. |0
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EI@ = gement e ; tbiDocuments 3
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tbiRuleSchemas 1
tblRuleSteps 1
tblFudeSubSteps 1
tblSysData 14
bt orkstations 0

Figure 6 Database Information subnode in Management
To access the Database Information subnode:

Step 1 > Launch the ARCHIVING Server
Administration from the Windows Start menu.

Step 2 > Select the Management node in the navigation
tree.

Step 3 > Select the Database Information subnode in the
Management node.

This subnode allows you to view statistical information on
the ARCHIVING Software tables in the database, tables list
and number of records per table.

[ Note |
The tables of the UMSS and MSGS subsystems are not
displayed in this subnode.
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Workstation
Settings
Subnode

o Bl acton Wew Favortes Window Heb
€=+ 0@ 72 SHL

[= -5 Sattings
B Funttions

(7] Watermark
= {4] Management

|. Connections
FL) Tasks
#- ] Documenks

5] Dakabase information
'.F:.' Warkskation settings

4 ARCHIVING SERVER administe || 4o Rafwh || New || Dses |
T ARCHIVING SERVER settings

J Hisbory sethings bk

Figure 7 Workstation Settings subnode in Management
To access the Workstation Settings subnode:

Step 1 > Launch the ARCHIVING Server
Administration from the Windows Start menu.

Step 2 > Select the Management node in the navigation
tree.

Step 3 > Select the Workstation Settings subnode in the
Management node.

This subnode allows defining workstations that will NOT
receive notifications about user actions. For example, when
setting up an automated system, you may not want
document approval prompts to appear for certain
workstations.

To add a new workstation to the list, click the New button,
and then enter the workstation name in the corresponding
Name text box. To save the changes, click Apply.
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* Apply

¢ Refresh

* New
¢ Delete

* Auto action popup

Connections
Subnode

The following controls are displayed:
Applies any changes made to the workstations list.

Displays the latest information about the workstations list
from the database.

Adds a new workstation to the list.
Deletes a workstation from the list.

When unchecked, the workstation does not receive
notifications about user actions.

Ty e i e Fegie Snas s

= @OEF SN

MO g1z e rdern B

Figure 8 Connections subnode in Management

To access the Connections subnode:

Step 1 > Launch the ARCHIVING Server
Administration from the Windows Start menu.

Step 2 > Select the Management node in the navigation
tree.

Step 3 > Select the Connections subnode in the
Management node.

This subnode shows the currently active connections to the
ARCHIVING Server.
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Tasks Node

Reset Documents
Subnode

The Disconnect button allows disconnecting selected
clients from the ARCHIVING Server.

To access the Tasks node:

Step 1 > Launch the ARCHIVING Server
Administration from the Windows Start menu.

Step 2 > Select the Tasks node in the navigation tree.

This node allows performing different operations with
database documents, such as resetting states, archiving,
import/export, etc.

When you select the Tasks node, the Reset Documents,
Delete History Records, Delete Documents and Data,
Archiving, Export Database, and Import Database
subnodes become available.

To access the Reset Documents subnode:

Step 1 > Launch the ARCHIVING Server
Administration from the Windows Start menu.

Step 2 > Select the Tasks node in the navigation tree.

Step 3 > Select the Reset documents subnode in the
Tasks node.

This subnode contains two additional subnodes: Check out
state and Valid from date, which allow resetting documents
based on the Checkout state or Valid from date.

The Checkout state subnode shows a list of all currently
checked out documents.
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Figure 9 Checkout State subnode in Reset Documents

If desired, you can select documents using the check box in
the Select column, and then reset their state using the
Reset button.

The Valid from Date subnode allows modifying that date for
any document that is in Final state.

‘) Fle  Action Miew Favorites  Window  Help
e« 0B 2 SH

i ARCHIVING SERVER. administration
% ARCHIVING SERVER settings

B %8> Settings -

#-{Z1] Managemenk Fesel

B Tasks

=] Reset documenits Fliey IDWQI Md’“'

=] Checkout state
(] Walid from date First date | 4282008
&1 Delete history entries

Ll L«

| Delete documents and data Last date | 4s26/2008
i1 Archiving = [ LABEL DESIGHER
L Export database -~ [£] Test labelz

[ Import database [ Common category

B ~f] Documents
Figure 10 Valid from Date subnode in Reset Documents
The Valid from Date subnode contains three tabs:

Filter tab allows filtering Final documents by date interval
and by category.
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Documents tab allows selecting documents individually.

Change date tab allows changing the Valid from Date of
selected documents.

If desired, you can select documents using the check box in
the Select column, and then reset their Valid from Date
using the Reset button.

Delete History To access the Delete History Records subnode:
Records
Subnode Step 1 > Launch the ARCHIVING Server

Administration from the Windows Start menu.
Step 2 > Select the Tasks node in the navigation tree.

Step 3 > Select the Delete History Records subnode in
the Tasks node.

This subnode allows deleting history records using state,
date interval and category tree filters.

The Delete History Records subnode contains two tabs:
Filter tab allows filtering documents by date and category.

Documents tab allows selecting documents individually
and then clicking on Delete to clear their history entries.
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Figure 11 Delete History Records subnode in Tasks
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Delete

Documents And
Data Subnode
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Figure 12 Delete Documents and Data subnode in Tasks

To access the Delete Documents and Data subnode:

Step 1 > Launch the ARCHIVING Server
Administration from the Windows Start menu.

Step 2 > Select the Tasks node in the navigation tree.

Step 3 > Select the Delete Documents and Data subnode
in the Tasks node.

This subnode allows deleting documents from the
ARCHIVING Server database using state and category tree
filters.

The Delete Documents and Data subnode contains two tabs:

Filter tab allows filtering documents by state and category.

Documents tab allows selecting documents individually
and then clicking on Delete to delete the documents.
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Archiving
Subnode
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Figure 13 Archiving subnode in Tasks
To access the Archiving subnode:

Step 1 > Launch the ARCHIVING Server
Administration from the Windows Start menu.

Step 2 > Select the Tasks node in the navigation tree.
Step 3 > Select the Archiving subnode in the Tasks node.

This node allows archiving the ARCHIVING Server
database to a Microsoft Access file (.mdb file). Filtering is
performed by document state and by category. Please note
that the Archiving task will create a backup of all database
tables including approval rules, user actions, etc.

The Archiving subnode contains three tabs:
Filter tab allows selecting documents by document states
(Active versions, Design state, Old final state) from the

specified categories.

Documents tab allows selecting the desired documents for
the archiving manually by selecting check boxes.

Archive Options tab allows specifying the Access
database file (.mdb file) for the archiving in the Database
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Export Database
Subnode

“ File

Action  View  Fawvorites

text field. The Browse button allows selecting a file from the
list of existing databases or creating a new database
archiving file. The Delete after archive check box allows
removing the selected documents from the ARCHIVING
Software database after performing the archiving
operation.

The Archive button performs the archiving operation.

Window  Help

= A2 SE

8 ARCHIVING SERYER administrative tools | Export database
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Figure 14 Export Database subnode in Tasks

To access the Export Database subnode:

Step 1 > Launch the ARCHIVING Server
Administration from the Windows Start menu.

Step 2 > Select the Tasks node in the navigation tree.

Step 3 > Select the Export Database subnode in the
Tasks node.

This subnode allows exporting the database to a Microsoft
Access file (.mdb file). Please note that the Export task
creates a backup only for documents, categories and
sysdata database tables.
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The Export Database subnode contains three tabs:

Filter tab allows selecting documents by document states
(Active versions, Design state, Old final state) from the
specified categories.

Documents tab allows selecting the desired documents for
exporting manually by selecting check boxes.

Export Options tab allows specifying a database file for
exporting in the Database text field. The Browse button
allows selecting a file from the list of existing databases or
to creating a new database exporting file.

The Export Database button performs the exporting
operation.

Import Database
Subnode
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Figure 15 Import Database subnode in Tasks
To access the Import Database subnode:

Step 1 > Launch the ARCHIVING Server
Administration from the Windows Start menu.

Step 2 > Select the Tasks node in the navigation tree.

Step 3 > Select the Import Database subnode in the
Tasks node.

This node allows importing the existing database from a
Microsoft Access file (.mdb file) to the ARCHIVING
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Software database. Please note that the Import task works
only with a database structure that is compatible with your
ARCHIVING Software version.

The Import Database subnode contains three tabs:

Import source tab allows specifying the existing Access
database file (.mdb file) in the Database text field or using
the Browse button to browse the file system to select a file.

Documents tab allows selecting the desired documents for
importing manually from the specified database by selecting
check boxes.

Options tab allows specifying the target category in the
ARCHIVING system database for import. Use the Target
root category tree for this purpose.

Create sub folder check box allows importing the whole
categories structure from the source Access database file
(.mdb file) to the archiving database. If it is unchecked, no
categories will be created and all documents will be written
to the target root category.

Conflict resolution options allow setting the behavior of an
import when encountering documents that have the same
names and versions.

Stop import terminates the import task when a first
document conflict is encountered.

Skip documents skips any duplicate conflicting document.

Overwrite target overwrites any target conflicting document.
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Import Database button performs the importing operation.
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Figure 16 Import Database Options
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Figure 17 Documents node

To access the Documents node:

Step 1 > Launch the ARCHIVING Server
Administration from the Windows Start menu.

Step 2 > Select the Documents node in the navigation
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Category
* Name

* Application

¢ Lock at check out

* Archiving

* Approval

* 3-state Approval

tree.

This node allows changing document handling settings for
the ARCHIVING Software.

This Documents node contains two tabs: Category and
Documents.

The name of the currently selected category.

Shows the name of the Label Designer application in
which the category was created. It has to be changed if a
user wants to work with another Label Designer.

Handler

Shows the name of the technical class which can work
with documents stored in the category.

When On, if a document is checked out by one user, other
users can only do a reprint. When Off, other users can
also open a document for print only.

When the archiving is switched On, the versioning is
active for all documents. At check-in a document can no
longer be overwritten and a new version needs to be
created. When the archiving is switched Off, the
document version number is not increased at check-in.
New documents overwrite previous ones.

If approval is Off, then only Final state can be assigned to
documents. If approval is On, then at least two document
states can be assigned: Draft and Final.

3-state Approval can only be activated if Approval is
enabled. When it is On, the In Approval state can be
chosen for documents, in addition to the Draft and Final
states.

The following settings: Archiving, Approval, and 3-
State Approval are defined both at category level in the
ARCHIVING Client Administration, and at global level in
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the ARCHIVING Server. To be activated for a given
document, they need to be switched ON both at
category level and at global level.

¢ Default approval Shows the approval rule selected by default for documents
rule of this category.

¢ Allow custom rules When On, the user who submits a document for approval
can choose a specific approval rule, different from the
default one.

Documents This tab displays the list of documents. You can view
document states, versions and other information in the grid.
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CHAPTER 5

ARCHIVING Client Administration

Logging In

User m

Pazsword | [~ Change

Figure 1 ARCHIVING Server Client Login

To launch the ARCHIVING Client Administration:

Step 1 > Launch the ARCHIVING Client Administration
from the Windows Start menu.

Step 2 > Type a valid user name and password (i.e.,
defined in UMSS and having appropriate permissions).

The Change check box allows changing the password at
any time.
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Figure 2 ARCHIVING client administration
Upon successful login, the Administration window will appear.

This window allows changing different settings for the
ARCHIVING Client module.

The settings for the server are accessible from the
ARCHIVING Server Administration.

The layout of the ARCHIVING Client Administration window
follows the Microsoft Management Console (MMC)
standard.

Three buttons are added to the default set of MMC:
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* Navigation Tree

* Work Pane

* Navigation

Client
Configuration
Node

¢ Internal Client

A save: Saves all changes made in the current window.

% Refresh: Cancels all changes made in the current
window and refreshes its state.

“a Add additional item: This is a content-dependent
button which appears on Approval rules and Documents
tree screens.

In this tree console, the user can select all functions
available in the Administration program.

Depending on the selected node in the navigation tree, the
right-side work panes are updated.

Depending on the selected node in the navigation tree, the
work pane displays the associated settings.

Single functions are chosen by selecting a node in the
navigation tree. When there is no functionality for a parent
node, a page is shown to indicate that you must select a
subnode.

To access the Client Configuration node:

Step 1 > Launch the ARCHIVING Client Administration
from the Windows Start menu.

Step 2 > Select the Client Configuration node in the
navigation tree.

This node allows the client to set up the connection to the
ARCHIVING Server. The user must select an Internal
client or an External client connection.

Specifies the settings for the internal client (this is a client
that is located on the same network domain as the
ARCHIVING Server). In this case, the TCP protocol is used.

+ Server name — specifies the name of the
ARCHIVING Server.

* Browse button — allows the user to search for the
ARCHIVING Server in the internal network.
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Port — specifies the port of the ARCHIVING Server
(8088 by default).

¢ External Client Specifies the settings for the external client (this is a client
that connects to the ARCHIVING Server via the Internet). In
this case, the HTTP protocol is used and all content, which
is transmitted between client and server, gets encrypted.

Server name - specifies the name of the
ARCHIVING Server.

Port — specifies the port of the ARCHIVING Server
(8080 by default).

Domain authentication — If the ARCHIVING Server
is installed on a network domain that requires
authentication, authentication settings must be spec-
ified.

User Name — specifies the user name to use for log-
ging in to the network domain.

Password — specifies the password.

* Proxy The ARCHIVING Server Client may be installed on a PC,
which is placed behind a proxy. In this case, the proxy
settings should be set.

Server Name — specifies the name of the proxy;

Browse button - allows the user to search for a
proxy on the internal network

Port — specifies the proxy port;

Proxy authentication — the proxy may require
authentication. In this case, user credentials should
be set:

User Name — specifies the user name.

Password — specifies the password.

¢ SSL Channel If the ARCHIVING Server is installed behind a firewall which
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Approval Rules
Node

only allows SSL access, this setting enables the client to
connect to the ARCHIVING Server using SSL.

The Test button allows testing the connection to the
ARCHIVING Server.

The Languages options allow you to specify the desired
language for the user interface.

For a language change to be fully effective you need to
close and re-open the application.

To access the Approval Rules node:

Step 1 > Launch the ARCHIVING Client Administration
from the Windows Start menu.

Step 2 > Select the Approval Rules node in the navigation
tree.
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Figure 3 Approval Rules node
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This node allows creating custom approval rules, and
specifying the number of steps, parameters, notification
options, etc. You can see the currently available rules using
the Rules drop-down list.

The Approval Rules node displays four buttons:
* Apply Applies any changes made on this screen.

* Refresh Displays the latest information from the database about the
approval rules.

* New Creates a new rule. You can specify a rule name in the
Name text box.

¢ Delete Deletes the selected rule.

The main grid in the middle of the Approval Rules work pane
displays the steps that make up the currently selected rule.
You can specify the following parameters for each approval
step:

» State Possible values: Always, Failed, One of the steps failed,
One of the steps succeeded, Success.

« Always: The current step will always be executed,
no matter if the previous step failed or not.

+ Failed: The current step will be executed if the previ-
ous one failed.

* One of the steps failed: The current step will be
executed if one of the previous steps or substeps
failed.

* One of the steps succeeded: The current step will
be executed if one of the previous steps or substeps
succeeded.

» Success: Works if the previous step or substep suc-
ceeded.

* Handler Defines whether an action is required by a single user or by
a user group in order to complete the current step. Possible
values: Single User, Usergroup.
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e Parameter

* Type

* Stop at one deny

Specifies the user name or user group name according to
the previous Handler field.

Defines the type of user participation in the approval
workflow. Possible values are: Can Approve, Must
Approve.

Allows terminating the execution of the entire rule upon first
deny of an approval workflow.

* Reminder Allows setting an approval reminder to appear after the
specified number of days.
The e-mail and Action options define the type of approval
notification — via e-mail message (single users only) or via
an action table on the Label Designer startup.
Documents To access the Documents node:
Node
Step 1 > Launch the ARCHIVING Client Administration
from the Windows Start menu.
Step 2 > Select the Documents node in the navigation
tree.
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Figure 4 Documents node
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Category

* Name

* Application

e Handler

Lock at check out

* Archiving

e Approval

3-state Approval

The Documents node contains two tabs: Category and
Documents.

This tab allows changing document handling settings for the
ARCHIVING Software.

The name of the currently selected category.

Shows the name of the Label Designer application in which
the category was created.

Shows the name of the technical class which can work with
documents stored in the category.

When On, if a document is checked out by one user, other
users can only do a reprint. When Off, other users can also
open a document for print only.

When the archiving is switched On, the versioning is active
for all documents. At check-in a document can no longer be
overwritten and a new version needs to be created. When
the archiving is switched Off, the document version number
is not increased at check-in. New documents overwrite
previous ones.

If approval is Off, then only Final state can be assigned to
documents. If approval is On, then at least two document
states can be assigned: Draft and Final.

3-state Approval can only be activated if Approval is
enabled. When it is On, the In Approval state can be
chosen for documents, in addition to the Draft and Final
states.

The following settings: Archiving, Approval, and 3-
State Approval are defined both at category level in the
ARCHIVING Client Administration, and at global level in
the ARCHIVING Server. To be activated for a given
document, they need to be switched ON both at
category level and at global level.
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¢ Default approval Shows the approval rule selected by default for documents
rule of this category.

* Allow custom When On, the user who submits a document for approval can
rules choose a specific approval rule, different from the default one.
Documents This tab displays the list of documents. You can view

documents states, versions and other information in the
grid.
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